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Chapter 204

Conditional Power of
Superiority by a Margin
Tests for the Difference
Between Two Proportions
Introduction
In sequential designs, one or more intermediate analyses of the emerging data are conducted to evaluate whether the
experiment should be continued. This may be done to conserve resources or to allow a data monitoring board to
evaluate safety and efficacy when subjects are entered in a staggered fashion over a long period of time. Conditional
power (a frequentist concept) is the probability that the final result will be significant, given the data obtained up to
the time of the interim look. Predictive power (a Bayesian concept) is the result of averaging the conditional power
over the posterior distribution of effect size. Both of these methods fall under the heading of stochastic curtailment
techniques. Further reading about the theory of these methods can be found in Jennison and Turnbull (2000), Chow
and Chang (2007), Chang (2008), Proschan et.al (2006), and Dmitrienko et.al (2005).
This program module computes conditional and predictive power for the case when a two-sample z-test is used to
test superiority by a margin for two proportions.

Technical Details
All details and assumptions usually made when using a two-sample z-test to test the difference between two
proportions continue to be in force here.

Conditional Power
The power of an experiment indicates whether a study is likely to result in useful results, given the sample size.
Low power means that the study is futile: little chance of statistical significance even though the alternative
hypothesis is true. A study that is futile should not be started. However, futility may be determined only after the
study has started. When this happens, the study is curtailed.
The futility of a study that is underway can be determined by calculating its conditional power: the probability of
statistical significance at the completion of the study given the data obtained so far.
It is important to note that conditional power at the beginning of the study before any data are collected is equal to
the unconditional power. So, conditional power will be high even if early results are negative. Hence, conditional
power will seldom result in study curtailment very early in the study.

204-1
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Conditional Power of Superiority by a Margin Tests for the Difference Between Two Proportions

From Jennison and Turnbull (2000) pages 205 to 208, the general upper one-sided conditional power at stage k for
rejecting a null hypothesis about a parameter θ at the end of the study, given the observed test statistic, Z k , is
computed as

 Z I − z1−α I K + θ (I K − I k ) 
,
Puk (θ ) = Φ  k k


I
I
−
K
k


and the general lower one-sided conditional power at stage k is computed as

 − Z k I k − z1−α I K − θ (I K − I k ) 
,
Plk (θ ) = Φ 


IK − Ik


where

θ = the parameter being tested by the hypothesis
k = an interim stage at which the conditional power is computed (k = 1,…, K – 1)
K = the stage at which the study is terminated and the final test computed

Z k = the test statistic calculated from the observed data that has been collected up to stage k
I k = the information level at stage k
I K = the information level at the end of the study

z1−α = the standard normal value for the test with a type I error rate of α.
Let 𝑃𝑃1 and 𝑃𝑃2 be the population proportions in groups 1 and 2, respectively. If we define 𝛿𝛿 = 𝑃𝑃2 − 𝑃𝑃1 , such that
𝛿𝛿0 = 𝑃𝑃2.0 − 𝑃𝑃1 is the superiority difference boundary, 𝛿𝛿1 = 𝑃𝑃2.1 − 𝑃𝑃1 is the true population difference under the
alternative hypothesis, and 𝛿𝛿̂𝑘𝑘 = 𝑝𝑝2𝑘𝑘 − 𝑝𝑝1𝑘𝑘 is the estimated proportion difference from the observed data at stage
k, then the parameter 𝜃𝜃 to test the one-sided superiority by a margin alternative hypotheses of 𝐻𝐻1 : 𝛿𝛿 > 𝛿𝛿0 (higher
proportions better) or 𝐻𝐻1 : 𝛿𝛿 < 𝛿𝛿0 (higher proportions worse) and other conditional power calculation components
as outlined in Chang (2008) pages 70 and 71 are
𝜃𝜃 = 𝛿𝛿1 − 𝛿𝛿0 (the expected difference under the alternative hypothesis)

𝑍𝑍𝑘𝑘 = �𝛿𝛿̂𝑘𝑘 − 𝛿𝛿0��𝐼𝐼̂𝑘𝑘 (the superiority z-statistic computed from the observed data)

1  1
1 

I k = 2 
+
σ  n1k n2 k 
1 1
1
I K = 2  + 
σ  n1 n2 

−1

(the interim information level)

−1

(the final information level)

where

p jk is the sample proportion for group j, estimating Pj at stage k
Iˆk is the estimated information from the sample at stage k

n jk is the sample size in group j at stage k

204-2
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Conditional Power of Superiority by a Margin Tests for the Difference Between Two Proportions

n j is the final sample size in group j
𝜎𝜎 2 = 𝑝𝑝̅ (1 − 𝑝𝑝̅ ) with 𝑝𝑝̅ =

𝑃𝑃1 +𝑃𝑃2.1
2

Computing conditional power requires you to set 𝑃𝑃1 , 𝑃𝑃2.0 or 𝛿𝛿0, and 𝑃𝑃2.1 or 𝛿𝛿1. Their values can come from the
values used during the planning of the study, from similar studies, or from estimates made from the data that has
emerged.

Futility Index
The futility index is 1 − 𝑃𝑃𝑘𝑘 (𝜃𝜃)|𝐻𝐻1. The study may be stopped if this index is above 0.8 or 0.9 (that is, if
conditional power falls below 0.2 or 0.1).

Predictive Power
Predictive power (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution
of effect size. From Jennison and Turnbull (2000) pages 210 to 213, the general upper one-sided predictive power
at stage k is given by

 Z I − z1−α I k 
,
Puk = Φ  k K


I
I
−
K
k


and the general lower one-sided predictive power at stage k is given by

 − Z k I K − z1−α I k 
,
Plk = Φ 


I
I
−
K
k


with all terms defined as in the equations for conditional power.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Test
Higher Proportions Are
Use this option to specify the direction of the superiority test. If Higher Proportions are “Better”, the alternative
hypothesis is H1: δ > δ0, with δ0 > 0. If Higher Proportions are “Worse”, the alternative hypothesis is H1: δ < δ0,
with δ0 < 0.
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Alpha
Alpha
This option specifies one or more values for the probability of a type-I error at the end of the study. A type-I error
occurs when a true null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for two-sided tests and 0.025
for one-sided tests.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N1 (Group 1 Target Sample Size)
Enter one or more values of the target sample size of group 1, the total number of subjects planned for this group.
This value must be an integer greater than one. Note that you may enter a list of values using the syntax
50,100,150,200,250 or 50 to 250 by 50.
N2 (Group 2 Target Sample Size)
Enter a value (or range of values) for the target sample size of group 2 or enter Use R to calculate N2 from N1.
You may enter a range of values such as 10 to 100 by 10.
•

Use R
If Use R is entered here, N2 is calculated using the formula
N2 = [R(N1)]
where R is the Sample Allocation Ratio and the operator [Y] is the first integer greater than or equal to Y. For
example, if you want N1 = N2, select Use R and set R = 1.

R (Sample Allocation Ratio)
Enter a value (or range of values) for R, the allocation ratio between samples. This value is only used when N2 is
set to Use R.
When used, N2 is calculated from N1 using the formula: N2 = [R(N1)] where [Y] is the next integer greater than
or equal to Y. Note that setting R = 1.0 forces N2 = N1.
n1k (Group 1 Sample Size at k)
Enter the group 1 sample size obtained through look k. If this value is greater than N1, the value of N1 is
increased to this amount.
n2k (Group 2 Sample Size at k)
Enter the group 2 sample size obtained through look k. If this value is greater than N2, the value of N2 is
increased to this amount.
•

n1k
If n1k is entered here, n2k is set equal to n1k.
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Effect Size
Input Type
Indicate what type of values to enter to specify the differences. Regardless of the entry type chosen, the
calculations are the same. This option is simply given for convenience in specifying the differences.
The choices are
•

Proportions
Enter P1 (Group 1 Proportion), P2.0 (Superiority Proportion), and P2.1 (Actual Proportion). The differences
δ0 (Superiority Difference) and δ1 (Actual Difference to Detect) are calculated as
δ0 = P2.0 - P1,
δ1 = P2.1 - P1.

•

Differences
Enter P1 (Group 1 Proportion), δ0 (Superiority Difference), and δ1 (Actual Difference to Detect).

Effect Size – Group 1 Proportion (Reference)
P1 (Group 1 Proportion)
Enter one or more values for the probability of obtaining a success in group 1. This is the proportion of the group
1 population with the trait of interest.
You may enter a range of values such as 0.4 0.5 0.6 or 0.4 to 0.7 by 0.1. Since this is a proportion, all values must
be between 0 and 1.

Effect Size – Group 2 Proportion (Treatment)
P2.0 (Superiority Proportion)
This is the lower proportion bound used to create the superiority by a margin test hypotheses. The superiority
difference, δ0, is calculated from P1 and P2.0 as δ0 = P2.0 - P1.
When Higher Proportions are “Better”, P2.0 > P1 and the alternative hypothesis is H1: δ > δ0, or equivalently,
H1: P2 > P2.0. You can enter values in the range P1 < P2.0 < 1.
When Higher Proportions are “Worse”, P2.0 < P1 and the alternative hypothesis is H1: δ < δ0, or equivalently,
H1: P2 < P2.0. You can enter values in the range 0 < P2.0 < P1.
P2.1 (Actual Proportion)
This is the actual group 2 proportion at which conditional power is calculated. The actual difference to detect, δ1,
is calculated from P1 and P2.1 as δ1 = P2.1 - P1.
Care should be taken that this value is consistent with the alternative hypothesis.
When Higher Proportions are “Better”, you can enter values in the range P2.0 < P2.1 < 1.
Since Higher Proportions are “Worse”, you can enter values in the range 0 < P2.1 < P2.0.
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Effect Size – Difference
δ0 (Superiority Difference)
This is the difference bound of the superiority by a margin test hypothesis. When Higher Proportions are “Better”,
the alternative hypothesis is H1: δ > δ0 and you can enter values in the range 0 < δ0 < δ1 < 1. When Higher
Proportions are “Worse”, the alternative hypothesis is H1: δ < δ0 and you can enter values in the range -1 < δ1 <
δ0 < 0.
δ1 (Actual Difference to Detect)
This is the actual difference between the treatment proportion (P2) and the reference proportion (P1) at which
conditional power is calculated.
Care should be taken that this value is consistent with the alternative hypothesis.
When Higher Proportions are “Better”, 0 < δ0 < δ1 < 1.
When Higher Proportions are “Worse”, -1 < δ1 < δ0 < 0.

Effect Size – Current Test Statistic
Zk (Current Test Statistic)
Enter the value of the z-statistic calculated from the data obtained through stage k. This value may be positive or
negative. Typically, the z-statistic ranges between -5 and 5.
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Example 1 – Computing Conditional Power
Suppose a study has been planned and is to be analyzed using a one-sided superiority z-test against a lower
difference bound of δ0 = 0.05 at an alpha of 0.025. The reference group proportion (P1) is 0.6, so the difference
bound of δ0 = 0.05 corresponds to a superiority proportion of P2.0 = P1 + δ0 = 0.6 + 0.05 = 0.65. The target
sample size is 60 per group. An interim analysis is planned after half the data have been collected. The data
monitoring board would like to have the conditional power calculated for an actual difference of δ1 = 0.1 (P2.1 =
P1 + δ1 = 0.6 + 0.1 = 0.7) and z values of 1, 1.5, 2, 2.5, 3, and 3.5.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Conditional Power of Superiority by a Margin Tests for the Difference Between Two
Proportions procedure window by expanding Proportions, then Two Independent Proportions, then clicking
on Conditional Power, and then clicking on Conditional Power of Superiority by a Margin Tests for the
Difference Between Two Proportions. You may make the appropriate entries as listed below or open Example
1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Higher Proportions Are ........................................ Better (H1: δ > δ0)
Alpha .................................................................... 0.025
N1 (Group 1 Target Sample Size) ....................... 60
N2 (Group 2 Target Sample Size) ....................... Use R
R (Sample Allocation Ratio) ................................ 1.0
n1k (Group 1 Sample Size at Look k).................. 30
n2k (Group 2 Sample Size at Look k).................. n1k
Input Type ............................................................ Proportions
P1 (Group 1 Proportion) ...................................... 0.6
P2.0 (Superiority Proportion) ............................... 0.65
P2.1 (Actual Proportion) ...................................... 0.7
Zk (Current Test Statistic) .................................... 1 1.5 2 2.5 3 3.5

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sample Z-Test ────────────────────────────────────────────
Hypotheses: H0: P2 - P1 ≤ δ0 vs. H1: P2 - P1 > δ0

Cond.
Power
0.08600
0.19330
0.35725
0.55337
0.73702
0.87164

Pred.
Power
0.29262
0.56409
0.80743
0.94244
0.98878
0.99860

Total
Sample
Size
N1|N2
60|60
60|60
60|60
60|60
60|60
60|60

Current
Sample
Size
n1k|n2k
30|30
30|30
30|30
30|30
30|30
30|30

Proportions
P1|P2.0|P2.1
0.60|0.65|0.70
0.60|0.65|0.70
0.60|0.65|0.70
0.60|0.65|0.70
0.60|0.65|0.70
0.60|0.65|0.70

Differences
δ0|δ1
0.05|0.10
0.05|0.10
0.05|0.10
0.05|0.10
0.05|0.10
0.05|0.10

Test
Statistic
Zk
1.000
1.500
2.000
2.500
3.000
3.500

Alpha
0.025
0.025
0.025
0.025
0.025
0.025

Futility
0.91400
0.80670
0.64275
0.44663
0.26298
0.12836
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Report Definitions
Conditional Power is the probability of rejecting a false null hypothesis at the end of the study given the
data that have emerged so far.
Predictive Power is the result of averaging the conditional power over the posterior distribution of the
effect size.
N1|N2 are the anticipated total sample sizes of groups 1 and 2, respectively.
n1k|n2k are the sample sizes of groups 1 and 2, respectively, obtained through stage k.
P1 is the response proportion for group 1.
P2.0 is the superiority proportion for group 2 used to compute δ0.
P2.1 is the actual proportion for group 2 to detect under the alternative hypothesis used to compute δ1.
δ = P2 - P1 is the difference in proportions.
δ0 = P2.0 - P1 is the superiority difference used to construct the hypotheses.
δ1 = P2.1 - P1 is the actual difference to detect under the alternative hypothesis at which conditional power
is calculated.
Zk is the value of the test statistic from the observed data at stage k.
Alpha is the probability of rejecting a true null hypothesis.
Futility is one minus the conditional power. A value greater than 0.9 or 0.8 indicates the study should be
stopped because there is little chance of achieving statistical significance.
Summary Statements ─────────────────────────────────────────────────────────
The first 30 of 60 subjects in group 1 and 30 of 60 subjects in group 2 achieve 8.600%
conditional power to detect a difference of δ1 = P2.1 - P1 = 0.70 - 0.60 = 0.10 using a Z-test
for superiority by a margin with a difference bound of δ0 = P2.0 - P1 = 0.65 - 0.60 = 0.05 and
a significance level of alpha = 0.025. The value of the test statistic from data that have
emerged so far is Zk = 1.000. The futility index is 0.91400.

This report shows the values of each of the parameters, one scenario per row. The definitions of each column are
given in the Report Definitions section.

Plots Section

This plot shows the relationship between conditional power and Zk.
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Example 2 – Validation
We could not find an example of a conditional power calculation for a one-sided superiority by a margin
proportions test in the literature. Since the calculations are relatively simple, we will validate the calculation of the
third scenario (Zk = 2) of Example 1 by hand.
In this case
𝑝𝑝̅ =

𝑃𝑃1 + 𝑃𝑃2.1 0.6 + 0.7
=
= 0.65
2
2

𝜎𝜎 2 = 𝑝𝑝̅ (1 − 𝑝𝑝̅ ) = 0.65(0.35) = 0.2275
1 1
1 −1
1
1
1 −1
𝐼𝐼𝑘𝑘 = 2 �
+
� =
� + � = 65.9341
𝜎𝜎 𝑛𝑛1𝑘𝑘 𝑛𝑛2𝑘𝑘
0.2275 30 30

𝐼𝐼𝐾𝐾 =

𝑃𝑃𝑢𝑢𝑢𝑢 (𝜃𝜃) = Φ �
= Φ�

1 1
1 −1
1
1
1 −1
�
+
�
=
�
+
� = 131.8681
𝜎𝜎 2 𝑛𝑛1 𝑛𝑛2
0.2275 60 60

𝑍𝑍𝑘𝑘 �𝐼𝐼𝑘𝑘 − 𝑍𝑍1−𝛼𝛼 �𝐼𝐼𝐾𝐾 + 𝜃𝜃(𝐼𝐼𝐾𝐾 − 𝐼𝐼𝑘𝑘 )
�
�𝐼𝐼𝐾𝐾 − 𝐼𝐼𝑘𝑘

2√65.9341 − 1.9599640√131.8681 + 0.05(131.8681 − 65.9341)
�
√131.8681 − 65.9341
= Φ(−0.36581)
= 0.35725

This value matches the third line of the report in Example 1.

204-9
© NCSS, LLC. All Rights Reserved.

